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RESUMEN

El Bioespeckle se desarrolla através de un video en el cual se captura
lainterferenciade un haz de luzlaser, al incidir con una superficie rugosa
0 con movimiento. Este fenGmeno permite analizar muestras biologicas.
En este trabajo se busca establecer herramientas que permitan distinguir
la presenciay ausencia de microorganismos, asi como las relaciones en
sus dimensiones. El disefio de esta investigacion sera de laboratorio,
retrospectivo, transeccional y multieventual. La “n” muestral,
corresponde a diez (10) videos tomados en experiencias previas, los
cuales fueron procesados en el laboratorio de la Seccion Biotecnologia
del Instituto de Investigaciones de la Facultad de Farmacia y Bioanalisis
de la Universidad de Los Andes. Los videos se estudiaron por tendencia
espacial y tendenciatemporal. En la primera se evaluaron las ecuaciones
de las semi elipses y el area de las mismas. En la segunda los videos se
analizaron por las ecuaciones de sus semi elipses y por descriptores
estadisticos, respectivamente. Se concluyé que la forma de los
microorganismos puede distinguirse por el area de las semi elipses en la
tendencia espacial, siendo el coeficiente de variacibn mayor para
parasitos que para bacterias y por el movimiento en la tendencia
temporal, siendo la relacion del coeficiente de variacion mayor para
bacterias que para parasitos debido al mayor movimiento de las primeras
frente a los segundos.

Palabras Clave: laser, Speckle, bioespequelometria, bacterias. parasitos,

tendencia espacial, tendencia temporal, Escherichia coli, Trypanosoma
cruzi.
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INTRODUCCION

La capacidad del laboratorio para realizar el diagndstico y el control de las
enfermedades causadas por parasitos y bacterias se encuentra limitada por
factores como la calidad de la muestra recogida en el paciente, el medio de
transporte de la muestra al laboratorio y las técnicas utilizadas para demostrar
la presencia del microorganismo. Los parasitos son los microorganismos con
mayor grado de complejidad. La mayoria de las pruebas diagndsticas se basan
en la capacidad de evoluciéon del microorganismo y las condiciones del
transporte han de asegurar su viabilidad e integridad (Murray, 2009).

Por otro lado, la identificacion bacteriana y las pruebas de susceptibilidad a
los antibiéticos son un paso necesario antes del tratamiento clinico de las
infecciones bacterianas, una preocupacion importante es el tiempo requerido
para obtener un resultado rapido y confiable (Grassi et al, 2019).

En la seccion Biotecnologia se ha evaluado la posibilidad de usar el
Bioespeckle como sistema para realizar antibiogramas, por ello se esta
evaluando toda la metodologia concerniente con Bioespeckle para establecer
un sistema de antibiograma rapido que le facilite al Bioanalista asistir al médico
y obtener un resultado en menor tiempo.

Las muestras fueron recolectadas de videos capturados en experiencias
previas, los cuales fueron procesados en el laboratorio de la Seccion
Biotecnologia del Instituto de Investigaciones de la Facultad de Farmacia y
Bioanalisis de la Universidad de Los Andes. Se estudiaron por tendencia
espacial y tendencia temporal. En la primera se evaluaron las ecuaciones de
las semi elipses y el area de las mismas. En la segunda los videos se
analizaron por las ecuaciones de sus semi elipses y por descriptores
estadisticos, respectivamente.

Este trabajo de investigacion esta estructurado en cinco capitulos. El
primero titulado ElI Problema, esta subtitulado de la siguiente manera:

Planteamiento del Problema, Justificacion de la Investigacion, Objetivos,



Alcances y Limitaciones. El segundo capitulo, titulado Marco Tedrico, estara
conformado por los Antecedentes Historicos, Bases Teodricas, Definicion
Operacional de Términos, Operacionalizacion del Evento de Estudio y el
Criterio de Andlisis. El tercero, titulado Marco Metodoldgico esta ordenado con
los siguientes subtitulos, Tipo de Investigacién, Disefio de la Investigacion,
Poblacion y Muestra, Variables estadisticas, Metodologia de la Investigacion

y Disefio de analisis de los datos. El cuarto capitulo consta de los
Resultados y Discusiones. Y el quinto capitulo hace referencia a las
Conclusiones y Recomendaciones.

Finalmente, El objetivo de esta investigacion es, analizar imagenes de
videos de Bioespeckle contentivos de muestras de cultivo controlado de
Trypanosoma cruzi y Escherichia coli para distinguir tanto la presencia y
ausencia como las dimensiones de los dos microorganismos, en la Seccién
Biotecnologia del Instituto de Investigaciones de la Facultad de Farmacia y
Bioanalisis de la Universidad de Los Andes, desde noviembre de 2019 hasta
marzo de 2020.



CAPITULO |

EL PROBLEMA

Planteamiento del problema

Segun la OMS la enfermedad de Chagas, causada por el protozoario
Trypanosoma cruzi, constituye una amenaza permanente para casi la cuarta
parte de la poblacion de América Latina. Inicialmente la enfermedad de
Chagas estaba confinada a esta region, pero en la actualidad se ha se ha
propagado a otros continentes. cerca de 100 millones de personas estan en
riesgo de infectarse, unos 8 millones estan infectadas, con 56.000 nuevos
casos anuales por todas las formas de transmisiébn que provocan 12.000
muertes anuales. La enfermedad persistirdA mientras exista la vivienda
inadecuada, la migracion frecuente de las personas y la rapida urbanizacion.
Hasta que no cambien esas condiciones debera continuarse la lucha contra la
infeccion (Martinez, 2016).

Uno de los problemas diagnosticos en la enfermedad de Chagas es la
visualizacion del parasito etiologico, ya que, si bien se trata de un organismo
visible al microscopio y muy movil, se presenta en concentraciones muy bajas
(100 parésitos/ ml o menos). Lo cual impide la deteccién por microscopia
Optica, por ello se procura obtener un método de deteccién en profundidad de
campo, lo cual no es posible lograr con microscopio (Lanis et al,1991).

Escherichia coli se ha asociado a infecciones gastrointestinales, infecciones
del tracto urinario, infecciones en piel, bacteriemias, entre otros. La alta

morbilidad, asi como la variedad en sindromes y cuadros clinicos



asociados a las infecciones por E. coli, hacen de esta bacteria uno de
patdgenos mas versatiles y de gran relevancia para el ser humano. Las
pruebas de susceptibilidad a los antibidticos son un paso necesario antes del
tratamiento clinico de las infecciones, una preocupacién importante es el
tiempo requerido para obtener un resultado rdpido y confiable (Farfan et al,
2016).

En la Ultima década, se ha desarrollado una técnica éptica que permite
relacionar la actividad que se presenta sobre la superficie de una muestra, con
las variaciones en la intensidad de la luz que refleja. Esto sucede cuando es
iluminada con luz coherente (Laser). El fundamento de esta técnica, considera
que cuando la micro-geometria de la superficie de la muestra presenta
rugosidades del orden de la longitud de onda de la luz incidente, se produce
reflexion difusa. En consecuencia, se generan ondas secundarias que
interfieren para conformar un patrén de manchas oscuras y brillantes que
parecen cubrir el objeto y que se denomina Speckle.

Patifio, Vencue y Vargas (2016) afirman:

Si existe algun tipo de actividad sobre la superficie, las trayectorias Opticas de
las ondas secundarias se alteran, lo que origina fluctuaciones, tanto espaciales
como temporales, en el Speckle observado. A este fendmeno se le denomina
Speckle dindmico o Bioespeckle (si se realiza a una muestra biolégica). La
capacidad de esta técnica de realizar medidas sin contacto directo, de forma
rapida y a bajo costo, la han convertido en un método promisorio para el

desarrollo de sistemas de medida de propiedades biologicas (p.86).

Las teorias y aproximaciones tedricas que sustentan esta investigacion
estan relacionadas con la reflexion difusa de la luz y la trayectoria éptica de
las ondas secundarias. Al respecto, la reflexién difusa se refiere a la energia
que es reflejada por cualquier superficie irregular (Marcelo y Finn, 1998). Y la

trayectoria Optica de las ondas secundarias se refiere a que estas son



desviadas por una superficie o un medio generando fenébmenos virtuales como
es el caso del Speckle (Rodriguez & Virgos, 1999).

La situacion actual del problema de estudio ha sido divulgada por varios
autores, en los ultimos 5 afios. Al respecto, Grassi et al, 2019. Disefiaron un
ensayo de Bioespeckle laser para la evaluacion de susceptibilidad a la
Ciprofloxacina de una cepa de E. coli K-12. El procesamiento digital de
imagenes se realizé mediante tres métodos que fueron comparables a las
pruebas de susceptibilidad antimicrobiana clasicas en términos estadisticos.
En este sentido, concluyeron que el método Bioespeckle laser permite analizar
fluidos corporales, asi como otras muestras, y abre un camino posible para
evaluar la susceptibilidad a los antibiéticos de forma rapida.

Contreras, 2016 Determino la actividad del Trypanosoma cruzi en presencia
de farmacos usando la técnica de Bioespeckle con dos modalidades de
procesamiento de imagenes. Refirid, que es mas efectivo el método indirecto
o0 método de imagen de diferencias acumuladas de base variable (IDABV).

Moreno (2015) Publicé que el Bioespeckle es una técnica no invasiva que
permite realizar andlisis en tiempo real, y con tiempos de captura y
procesamiento de imagenes reducidos (minutos). También, refiri6 que esta
técnica puede ser usada en laboratorios clinicos con una reduccion del tiempo
de obtencién de resultados. En cuanto a la utilidad del Bioespeckle ha sido
divulgado que, permite detectar actividad bacteriana y presencia de parasitos
en medios de cultivo (Moreno, 2015; Griffin, 2015).

La investigacion ha revelado que con la técnica de Bioespeckle es
importante considerar algunas variables que pueden influir sobre el sistema.
En tal sentido, se han identificado variables tales como camara, resolucion,
aumento, etapas del crecimiento, presencia de antibiético en el caso del
estudio de actividad bacteriana (Moreno, 2015).

Griffin, 2015 Refiri6 que la bioespequelometria es una técnica que puede
sustituir ensayos in vitro con Trypanosoma cruzi, ya que es mas rapida y evita

la contaminacion del medio.



Después de describir la situacion actual del problema, los autores de esta
investigacion formulan el siguiente enunciado holopraxico:

¢Cual es la relacibn de correspondencia entre las dimensiones de
Escherichia coli y Trypanosoma cruzi con la bioespequelometria, en videos de
cultivos controlados, en la Seccion Biotecnologia, del Instituto de
Investigaciones, de la Facultad de Farmacia y Bioanalisis, de la Universidad

de Los Andes, desde noviembre de 2019 hasta marzo de 20207

Justificacion

La justificacion de la investigacion alude a las razones que llevaron al
investigador a seleccionar el tema en cuestion. Partiendo de, potencialidades,
necesidades, oportunidades y tendencias del tema de estudio; las cuales,
sirven como fundamento para realizar dicha investigacion (Hurtado, 2010).

Los autores de esta investigacion identificaron razones de oportunidad,
necesidad y potencialidad en el estudio de Trypanosoma cruzi, causante de la
Enfermedad de Chagas, la cual se presenta principalmente en América Latina
tanto en la poblacion de zonas urbanas como rurales. Por otro lado,
Escherichia coli, por ser uno de los principales agentes causales de
infecciones del tracto urinario, enfermedad diarreica aguda, e infecciones
sanguineas y del sistema nervioso (Farfan et al, 2016), ha sido motivo de
interés en la realizaciéon de esta investigacion, considerando que la rapida
identificaciébn de estos microorganismos le permitira al médico aplicar un
tratamiento oportuno, que pueda conducir al bienestar del paciente.

En la seccion Biotecnologia se ha considerado la posibilidad de usar el
Bioespeckle como sistema para realizar antibiogramas, por ello se esta
evaluando toda la metodologia concerniente con Bioespeckle para establecer
un sistema de antibiograma rapido que le facilite al Bioanalista asistir al Médico
y obtener un resultado en menor tiempo. Sin embargo, hasta este momento

tiene la caracteristica que detecta muy bien la presencia y ausencia de



microorganismos en muestras clinicas y de control (en estado liquido), pero
no se ha puesto a punto una metodologia que permita detectar cual es el
patogeno infectante.

En este trabajo se esta en la bUsqueda de posibles soluciones para
distinguir entre dos tipos de microorganismos. Por lo tanto, esta investigacion

puede servir como base para ensayar con otros microorganismos.

Objetivos de la Investigacion

Objetivo General

Analizar imagenes de videos de Bioespeckle contentivos de muestras de
cultivo controlado de Trypanosoma cruzi y Escherichia coli para distinguir tanto
la presencia y ausencia como las dimensiones de los dos microorganismos,
en la Seccién Biotecnologia del Instituto de Investigaciones de la Facultad de
Farmacia y Bioanalisis de la Universidad de Los Andes, desde noviembre de
2019 hasta marzo de 2020.

Objetivos Especificos

e Caracterizar la tendencia espacial del Bioespeckle de Escherichia coli
en correspondencia con el Bioespeckle de Trypanosoma cruzi.
e Caracterizar la tendencia temporal del Bioespeckle de Escherichia coli

en correspondencia con el Bioespeckle de Trypanosoma cruzi.
Alcances y limitaciones de la investigacion
El alcance de una investigacion se relaciona con la profundidad del

conocimiento sobre el fendmeno de estudio. Establece la vision que posee el

investigador para lograr los objetivos (Herndndez, Fernandez y Baptista,



2010). En este sentido, el alcance de esta investigacion, serd Analizar
imagenes de videos de Bioespeckle contentivos de muestras de cultivo
controlado de Trypanosoma cruzi y Escherichia coli para distinguir los dos
microorganismos. Usando como criterio de analisis la bioespequelometria.
Durante el desarrollo de esta investigacion, se presentaron limitaciones
relacionadas con la muestra, debido a que los videos fueron grabados
anteriormente en condiciones prestablecidas por lo que no se pudo cambiar
las condiciones de ensayo. Ademas, en la obtencion de los videos influye la
estabilidad del laser y del flujo eléctrico, las vibraciones, el estado y la

concentracién de los microorganismos.



CAPITULO II

MARCO TEORICO

Antecedentes Histéricos

La primera teoria sobre el Speckle se desarroll6 en los afios 60. En los
afios 70, se comenz0 a investigar sobre la variacion temporal del Speckle
causada por el movimiento. Concretamente la conexién entre las fluctuaciones
del patron de Speckle y el movimiento de los centros de dispersion en los
organismos vivos. La manera en que se manifestaban las fluctuaciones en el
Speckle es la reduccién del contraste del patrén. En los 80, este efecto fue
usado para estudiar el flujo sanguineo en la retina (Fercher, 1981). Aunque la
técnica funcionaba, la necesidad de procesar las fotografias antes de poder
acceder a la informacion fue un problema y el interés en la técnica se
desvanecio. Ya en los afios 90, los nuevos métodos digitales, permitieron el
desarrollo de una versién en tiempo real del método mucho mas (til.

En la Seccion Biotecnologia, de la Facultad de Farmacia, de la Universidad
de Los Andes, se empez0 a estudiar la técnica de Bioespeckle desde el 2011.

Garcia, (2011) estandarizé el uso del Speckle dinamico para detectar la
presencia de parasitos, para ello realiz6 el ensayo en una placa de V.D.R.L. y
efectué grabaciones de cada pozo realizando videos de 60 segundos. Esos
videos se procesaron con un programa disefiado, elaborado y ejecutado por
Andrades, (2011), usando el método de las Diferencias Temporales. Los

resultados indican que los parasitos en presencia de los diversos farmacos



ensayados alcanzan un valor de media arrojado por el programa de Andrades,
(2011), mayor que en ausencia de farmacos, estimulandose el patron de
Speckle bajo estas condiciones, asi mismo, ésta relacion es dependiente de
la concentracion del farmaco. Finalmente, demostré que esta técnica puede
sustituir los ensayos in vitro, ya que es mas rapida y se evita la contaminacion
del medio.

Belandria, (2011) disefié experiencias de Bioespeckle tomando en cuenta
los resultados de otros investigadores, Garcia, (2011) y Lobo, (2011), pero
aplicadas a Escherichia coli. El disefio consistio en evaluar tanto el efecto de
la concentracion de antibiotico sobre la bacteria, como el tiempo de accion del
mismo, tratando de encontrar tanto la concentracion 6ptima como el tiempo
minimo para la deteccion por Bioespeckle. Para ello desarroll6 el Bioespeckle
con medio de cultivo, medio mas bacterias, medio mas bacterias mas
antibiotico y medio mas antibiético, inicialmente se observé que la presencia
de bacterias aumenta el patron de Speckle, ademas se decidié esperar un
tiempo prudencial de 15 minutos, y asi evitar los efectos por movimiento,
mezcla y difusion.

Los resultados demuestran que el Bioespeckle es mas eficiente con
respecto a tiempo que técnicas tradicionales como macrodilucion y difusién en
agar, por tanto, representa un meéetodo que tiene un valor predictivo para
obtener concentracion minima inhibitoria de un antibiético.

En esos tres trabajos, los videos se procesaron por el Programa de
Andrades (2011), el cual fue disefiado por el método de las diferencias
temporales tomadas de Pomarico y DiRocco, (2004). Este programa hace la
resta de las matrices de fotogramas consecutivos, y luego calcula la media de
cada matriz de diferencia y la media de las medias de diferencia, obteniendo
un solo valor de intensidad media final. Este método tiene la particularidad de
“normalizar” y disminuir las diferencias.

En los trabajos sucesivos se ha cambiado el andlisis hacia un sistema de

autocorrelacion comparando cada matriz con una matriz constante y tomando
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el cambio que ocurre en funcion del tiempo o pendiente, lo que ha mejorado
las diferencias entre videos. Este método ha sido denominado comparacién
de base constante.

En un estudio similar, realizado por Diaz y Gallego, (2013) se utilizd
Bioespeckle para medir el efecto de Ciprofloxacina sobre Escherichia coli, los
resultados permiten inferir que se puede distinguir materia viva de materia
muerta, ademas se encontré una posible correlacion entre la pendiente de la
tendencia lineal, la concentracién bacteriana y la concentracion del antibiotico,
tendiendo a ser mayor la pendiente cuando aumenta la concentracion de
bacterias, mientras que disminuye cuando aumenta el antibiético. En este
trabajo los videos también se procesaron manualmente por el método de
comparacion con base constante.

Los trabajos de Méndez, (2015) y Abche, (2015) han conducido al avance
en el procesamiento de imagenes. Méndez, (2015) examind las ecuaciones y
los algoritmos utilizados en el procesamiento y propuso un nuevo meétodo,
basado en los conceptos de flujo Optico, que denominamos método Optico
Imagen de Diferencias Acumuladas de Base Variable (IDABV). Abche, (2015)
tomé esa propuesta y reprocesé los videos obtenidos por Belandria, (2011) y
tomando en consideracion el modo de accion de los antibioticos utilizados,
contribuy0 a constatar que ese nuevo procesamiento es mas adecuado.

Todos los trabajos anteriores se llevaron a cabo con un ensamble manual
de laser, camara y porta muestras, que se armaba en un cuarto oscuro. A partir
del afio 2012, se comenz6 a elaborar un prototipo de Bioespeckle en el
contexto del Proyecto de Innovacién del Poder Popular para la Ciencia, la
Tecnologia y la Innovacion, intitulado: “Producto y proceso para medir el efecto
de antibidticos sobre microorganismos en un tiempo corto y utilizando
Bioespeckle” Proyecto N°. 2012001862.

Moreno, (2015) reunid las experiencias anteriores para mejorar los datos de
Bioespeckle. Para ello evalu6 el efecto del antibiotico Ampicilina—Sulbactam

sobre Escherichia coli, por Bioespeckle, usando laser verde en el prototipo
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construido y se evaluaron variables que inciden sobre este sistema, tales como
camara, resolucion, aumento, etapa del crecimiento, presencia de antibidtico,
etc. El procesamiento de videos se ha realizado por el método de comparacion
con base constante y por el método éptico IDABV. En ese contexto se ha
logrado poner a punto una metodologia de “Antibiograma por Bioespeckle” y
se ha evaluado la presencia de sistemas particulados para aumentar las
diferencias entre muestras vivas y aquellas afectadas por el antibiotico.

Todo este sistema de deteccion de microorganismos por Bioespeckle se
aplic6 a muestras de orina de pacientes que clinicamente tenian infeccién
urinaria y sus muestras se analizaron por VITEK y por Bioespeckle, Mufioz
(2015). Los resultados obtenidos en la comparacion de coincidencia paciente
por paciente, Vitek-Bioespeckle, es de 75%, concluyendo que el Bioespeckle
es capaz de detectar actividad bioldgica en muestras de orina y que pudiera
llegar a ser una prueba complementaria al analisis microbiol6gico tradicional,
tal como cultivo, antibiogramay VITEK, ya que, en un tiempo muy corto, podria
dar una indicacion al meédico para iniciar el tratamiento, que luego se
confirmaria por los métodos tradicionales.

Arrieche, (2016) aplico dos métodos (Método Directo y Método Indirecto o
Mejorado) para el procesamiento de imagenes de Bioespeckle a ensayos con
Trypanosoma cruzi en viales de cultivo profundo. Esta autora concluye que el
método directo no arroja resultados coherentes mientras que la aplicacién del
método IDABV con las herramientas adicionales de analisis de Bioespeckle
permiti6 obtener buenos resultados, en igualdad de condiciones de las
muestras y poder hacer el seguimiento a parasitos en cultivo.

Igualmente, Contreras, (2016) encontré0 que la aplicacion del método
mejorado de procesamiento de imagenes de Bioespeckle, permite hacer la
comparacion del efecto de farmacos sobre Trypanosoma cruzi.

Grassi et al, (2016) reunieron la informacion de Bioespeckle de T. cruzi y

compararon tres métodos de procesamiento de imagenes, logrando un
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sistema adecuado para estudiar el efecto de Benzinidazol sobre este parasito,
pudiendo describir un efecto inmediato y otro tardio.

Rodriguez, (2018) y Molina, (2018) utilizaron el Bioespequelometro y
analizando las imagenes por Diferencias Generalizadas (Método Indirecto)
aplicaron esta tecnologia a extractos de algas, detectando
Fotosensibilidad/Fotoactivacion de los extractos.

Contreras, (2018) y Sanchez, (2018) retomaron los resultados de Belandria,
(2011) y aplicaron la metodologia disefiada por Grassi et al, (2019) en la que
aplicaron los métodos de Seleccién ROI, Diferencias Generalizadas, Analisis
Exploratorio de Datos (Regresion lineal, Normalidad, Homocedasticidad,
Independencia) y ARIMA. Lady Garcia aplicé este mismo disefio experimental
a las muestras de orina de pacientes, del trabajo de Mufioz, (2015).

Grassi et al (2019) aplicaron técnicas de andlisis digital de imagenes a
videos obtenidos por Bioespequelometria de muestras control de laboratorio,
con el objetivo de demostrar el efecto de Ciprofloxacina sobre de Escherichia
coli K-12. Esto permiti6 proponer la posibilidad de hacer un antibiograma

rapido.

Bases Tedricas

Aproximacion tedrica sobre la Reflexion difusa de la luz

Cuando el laser impacta con un material, la energia foténica puede tomar
varias vias. Una es absorcion, que se refiere a que tan lejos es absorbido o
transferido el rayo dentro del material. Si el material absorbe la energia laser,
la energia radiante es convertida en energia térmica. Y la otra puede ser la
reflexion difusa que se refiere a la energia que es reflejada por cualquier
superficie irregular o con movimiento. Cuando ésta es irradiada por un haz de
luz (Marcelo y Finn, 1998).
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Aproximacién tedrica sobre la Trayectoria 6ptica de las ondas

secundarias

Una onda secundaria aparece cuando hay una interaccion de una onda
primaria con un medio u objeto, que desvia su trayectoria 0 cambia alguna de
sus propiedades. La trayectoria Optica de las ondas secundarias se refiere, a
que éstas son desviadas por una superficie o un medio y se interfieren con
trayectoria aleatoria en todas las direcciones, generando fenédmenos virtuales

como es el caso del Speckle (Rodriguez y Virgos, 1999).

Definicion Operacional de Términos

Tendencia temporal y Tendencia espacial

Una serie temporal o cronolégica es una sucesion de datos medidos en
determinados momentos y ordenados cronologicamente. Los datos pueden
estar espaciados a intervalos iguales (como la temperatura en un observatorio
meteoroldgico en dias sucesivos al mediodia) o desiguales (como el peso de
una persona en sucesivas mediciones en el consultorio médico).

Para el analisis de las series temporales se usan métodos que ayudan a
interpretarlas y que permiten extraer informacion representativa sobre las
relaciones subyacentes entre los datos de la serie 0 de diversas series y que
permiten en diferente medida y con distinta confianza extrapolar o interpolar
los datos y asi predecir el comportamiento de la serie en momentos no
observados (Chander, R. y Scott, M., 2011). El analisis de tendencias
cuantifica y explica los patrones en un conjunto de datos. En este caso, esos
datos pertenecen a un espacio determinado (tendencia espacial) o0 a un tiempo

determinado (tendencia temporal).
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Generalidades de Trypanosoma cruzi

T. cruzi es un protozoo unicelular polimorfico que pertenece al subfilo
Mastigophora, orden Kinetoplastida, familia Trypanosomatidae, que se
caracteriza por la presencia de un organelo llamado kinetoplasto que se
encuentra en la mitocondria y tiene una ubicacidén subterminal en el extremo
posterior.

Estos parasitos circulan entre huéspedes vertebrados como armadillos,
marsupiales, roedores, murciélagos, primates, ser humano, perros, gatos; y en
vectores intradomiciliarios, como el “chipo”, el cual es un artropodo
hematofago proveniente de la familia Reduviidade, subfamilia Triatominae,
Estos insectos habitan en las grietas y huecos de edificaciones mal
construidas tanto en zonas rurales como urbanas, se alimentan de la sangre
de personas mientras duermen. Los mamiferos salvajes y domésticos que son
picados e infectados actian como reservorios del parasito.

La forma parasitaria flagelada del T. cruzi se encuentra en el sistema
circulatorio del huésped y es conocida como el tripomastigote, este tiene
aspecto fusiforme y alargado de aproximadamente 12-30 ym de longitud;
posee un nucleo grande en su parte central, un flagelo y una membrana
ondulante que rodea todo el cuerpo. Dentro de las células hospederas, el
tripomastigote se convierte en amastigote, un estado vegetativo que se
caracteriza por su forma redondeada y no poseer flagelo, su tamafo
aproximado de 1,5 a 4 ym y suele aglomerarse formando nidos tisulares o
también llamados pseudoquistes. Dentro del ciclo del parasito existe una forma
morfologica intermedia llamada epimastigote, su tamafio es un poco menor
que el del tripomastigote, tiene de aspecto fusiforme, membrana ondulante

peguefa y no posee flagelo (Palmezano, et al, 2015).
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Generalidades de Escherichia coli K-12

Escherichia coli es un bacilo Gram negativo, oxidasa negativa, de acuerdo
a sus requerimientos de oxigeno son anaerobios facultativos de la familia
Enterobacteriaceae, con un tamafio promedio de 1,1-1,5 um de ancho y 2,0-
6,0 um de largo, consta de un cuerpo con forma elipsoidal, que se propulsa
gracias a la rotacion de un flagelo de unos 250 nm de espesor y que se
extiende por aproximadamente 15um. Esta bacteria coloniza el intestino del
hombre pocas horas después del nacimiento y se le considera un
microorganismo de flora normal, pero hay cepas que pueden ser patdgenas y
tener otros nichos, produciendo diferentes cuadros clinicos, entre ellos diarrea,

infecciones del tracto urinario, bacteriemias, etc. (Souza et al, 2001).

Fundamento del Bioespeckle

Cuando un haz de luz coherente (laser) ilumina una muestra irregular o con
movimiento, se produce un efecto de interferencia aleatoria con forma granular
gue se denomina Speckle. Es un patrén de interferencia producido por la luz
reflejada o dispersada desde diferentes partes de la superficie de la muestra
iluminada. Si la superficie es rugosa (variaciones de altura mayores a la
longitud de onda del laser usado), la luz de diferentes partes de la superficie
atraviesa caminos Opticos con diferentes longitudes antes de alcanzar el plano
imagen. La imagen resultante en un punto, es determinada por la
superposicion de todas las ondas que llegan a ese punto. Si la amplitud
resultante es cero, porque todas las ondas se cancelan, en dicho punto se vera
una mota oscura mientras que, si todas las ondas que llegan a ese punto lo
hacen en fase, se observara una intensidad maxima.

El Speckle dinamico es el resultado de la evolucion temporal de un patron
Speckle, donde las variaciones en los elementos de dispersion responsables

de la formacion del patron de interferencia en la situacion estatica producen
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los cambios que se observan en el patrén Speckle, donde sus granos cambian
su intensidad (nivel de gris), asi como su forma a lo largo del tiempo. El patron
dinamico muestra los cambios que, si se analizan a lo largo del tiempo,
representan la actividad del material iluminado. El efecto visual es el de un
liquido hirviendo o la imagen en un televisor lejos del ajuste (Ruiz, 2015).

Usos del Bioespeckle

El Bioespeckle es la designacion de Speckle dinamico cuando la aplicacion
se basa en material bioldgico. El tejido biol6gico es uno de los mas complejos
gue se puede encontrar en la naturaleza. Ademas, se dificulta su andlisis por
la variabilidad intrinseca presente entre una muestra y otra. Estos hechos
dificultan ain mas la comparacién de resultados entre muestras diferentes
incluso en presencia del mismo estimulo. En este contexto, se han aplicado
patrones de moteado para estudiar bacterias, parasitos, semillas y plantas
(Ramirez, 2011).

Parésito

Los parasitos son los microorganismos con mayor grado de complejidad,
aunque todos los parasitos se clasifican como eucariotas, algunos son
unicelulares y otros pluricelulares. su tamafo oscila desde protozoos diminutos
de tan solo 1-2 um de diametro (el tamafio de muchas bacterias) a helmintos
que pueden medir hasta 10 metros de longitud y artrépodos (pulgas). Son
organismos que so6lo pueden vivir a expensas de otros mas desarrollados,
pueden afectar a individuos del reino animal y vegetal. pudiendo llegar a
ejercer acciones muy perjudiciales en estos individuos, provocando incluso su
muerte (Murray, 2009).
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Bacteria

Las bacterias son microorganismos unicelulares sencillos que presentan un
tamafio de unos pocos micrémetros (por lo general entre 0,5 y 5 um de
longitud) y diversas formas, incluyendo filamentos, esferas (cocos), barras
(bacilos), sacacorchos (vibrios) y hélices (espirilos). Las bacterias
son  procariotas, por lo que, a diferencia de las células
eucariotas (de animales, plantas, hongos, etc.), no tienen el nicleo definido ni
presentan, en general, organulos membranosos internos. Generalmente
poseen una pared celular y esta se compone de peptidoglicano. Muchas
bacterias disponen de flagelos o de otros sistemas de desplazamiento y son

moviles (Murray, 2009).

Laser

La palabra laser es un acrénimo de las palabras inglesas: Light
Amplification by Stimulated Emision of Radiation, es decir, amplificacién de luz
mediante emision estimulada de radiacion. Realmente representa el nombre
de un dispositivo cuantico, que sirve para generar ondas electromagnéticas de
la gama Optica. El laser proporciona una forma de emision de radiacion
luminosa de caracteristicas especiales. La radiacion laser es monocromatica
(una sola longitud de onda), posee una gran direccionalidad (escasa
divergencia) y puede concentrar un elevado numero de fotones en fase, en
areas muy pequenfas.

Para la emision de luz visible a partir de un foco, debe comunicarse a éste
una energia (térmica, eléctrica, quimica, etc.) que excite sus atomos.
Generalmente se producira una desexcitacion inmediata con emisién continua
de radiaciones que, son heterocromaticas (de distinta longitud de onda), no
son coherentes (no se encuentran en fase), y se propagan en todas las

direcciones del espacio.
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La radiacion laser posee todas las propiedades de la luz; sin embargo, se
caracteriza por ser: monocromatica (todos sus fotones tienen igual longitud de
onda), coherente (todos los fotones se encuentran en fase temporal y espacial)
y direccional (el haz de radiacién presenta escasa divergencia, fruto de las dos
caracteristicas anteriores). La principal utilidad practica de la radiacion laser
reside en que concentra un gran numero de fotones por unidad de superficie.
Estas caracteristicas han permitido una gran diversidad de aplicaciones en el
campo de la tecnologia actual y, en concreto, en las ciencias de la salud
(Canales, 2007).

Procesamiento de imagenes

Es una técnica de compresion con pérdida, que consiste en comprimir un
rango de valores a un unico valor. Cuando el nimero de simbolos discretos en
un flujo dado se reduce, el flujo se vuelve mas comprensible.

El ojo humano es bastante bueno percibiendo las pequefas diferencias en
el brillo sobre un area relativamente extensa, pero no es tan bueno
distinguiendo la misma intensidad de variacion de brillo de alta frecuencia. Este
hecho permite reducir la cantidad de informaciéon requerida ignorando los

componentes de alta frecuencia (Mitchell y Pennebaker, 1997).
Operacionalizacién del Evento de Estudio y el Criterio de Analisis
Para operacionalizar el evento de estudio con el respectivo criterio de
analisis, es necesario la definicion conceptual y la operacional de los mismos

(Hurtado, 2010). En tal sentido, se operacionalizan con la finalidad de

identificar los elementos y datos empiricos que expresan su presencia.
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Tabla 1. Operacionalizacion del Evento de Estudio Tendencia Espacial

Evento de o o ,
. Definicién Conceptual Definicién Operacional
Estudio
Es wuna ecuacibn que | Se mide a través de la forma
_ describe la forma que el | ecuacional que presenta el
Tendencia _ _ _ _ _
_ microrganismo presenta en | mejor ajuste a los cambios
espacial _ _ _ _
el espacio evaluado por | espaciales de intensidad.
Bioespeckle.

Dimensiones

Indicador

Valor de intensidad media, expresado

en unidades arbitrarias.

Variables y coeficientes de la ecuacion

de tendencia.

(Molina O., 2020).

Tabla 2. Operacionalizacién del Evento de Estudio Tendencia Temporal

Eég?&gige Definiciéon Conceptual Definicién Operacional
Es wuna ecuacidbn que | Se mide a través de la forma

Tendencia describe la forma que el | ecuacional que presenta el

temporal microrganismo presenta a | mejor ajuste a los cambios
lo largo del tiempo | temporales de intensidad.
evaluado por Bioespeckle.

Dimensiones

Indicador

Valor de

intensidad media en

unidades arbitrarias.

Variables y coeficientes de la ecuacién

de tendencia.

(Molina O., 2020).
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Tabla 3. Operacionalizacion del Criterio de Analisis

Evento de
Estudio

Definicion Conceptual

Definiciéon Operacional

Bioespeckle

Es un fenémeno 6ptico que
permite  relacionar la
actividad que se presenta
sobre la superficie de una
las

muestra con

variaciones en la
intensidad de la luz que
refleja, cuando es

iluminada con luz

coherente (Laser)

(Patifio, Vencue y Vargas,

Cuando la micro-geometria de
la superficie de la muestra
presenta rugosidades del orden
de la longitud de onda de la luz
incidente, se produce reflexion
difusa, lo que genera ondas
secundarias que interfieren
para conformar un patron de
manchas oscuras y brillantes

que parecen cubrir el objeto.

2016).

Dimensiones

Indicador

Valor de intensidad media, calculada
método de

y el
diferencias temporales.

por el diferencias

generalizadas método de

(Garcia ,2011).

Valor de intensidad media disminuido
0 aumentado en comparacion con el

patrén.

(Molina O., 2020).
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CAPITULO Il

MARCO METODOLOGICO

Tipo de investigacion

Los tipos de investigacion que propuso Hurtado (2010), en el libro titulado
“Proyecto de investigacion”, se definen a través de la pregunta y el objetivo
general. De manera que este trabajo corresponde a una investigacion
Analitica. Este tipo de investigacion, trata de entender las situaciones en
términos de las relaciones de sus componentes. Intenta descubrir los
elementos que componen cada totalidad y las interconexiones que dan cuenta
de su integracion. La investigacién analitica implica el estudio del evento de
estudio en funcién de un criterio de analisis. Intenta identificar las sinergias
menos evidentes de los eventos analizados. La presente investigacion,
pretende entender la correspondencia de la forma y tamafio de Escherichia

coli y Trypanosoma cruzi con la Bioespequelometria.

Disefio de la Investigacion

Hurtado (2010), nos indica que el disefio de la investigacion se define a
traves del procedimiento para recolectar la informacion, esto se refiere a donde
y cuando se recopila la informacién, con el fin de dar respuesta a la pregunta
de investigacion. Al respecto, la muestra se recolecté en un ambiente creado,
en el laboratorio de la Seccidn Biotecnologia, del Instituto de Investigaciones,
de la Facultad de Farmacia y Bioanalisis, de la Universidad de Los Andes. La
temporalidad corresponde a un periodo retrospectivo y en un s6lo momento.
A su vez, la amplitud de la informacion es multieventual, los datos se tomaron

de videos elaborados en trabajos anteriores de Bioespequelometria de T. cruzi
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y E. coli. Por lo tanto, el disefio de esta investigacion es de laboratorio,

restrospectivo, transeccional y multieventual.

Poblacion y Muestra

Unidad de Investigacion

Se define la poblacién como el conjunto de elementos con caracteristicas
comunes que son objeto de andlisis y para los cuales seran validas las
conclusiones de la investigacion (Arias, 2006). En este caso, la unidad de
estudio esta representada por videos de parasitos (Trypanosoma cruzi),
bacterias (Escherichia coli) y sus respectivos controles, obtenidos en
experiencias  previas utilizando como criterio de andlisis la

Bioespequelometria.

Selecciéon del Tamarfo de la Muestra

La “n” muestral, corresponde a cuatro (04) videos de parasitos
(Trypanosoma cruzi) obtenidos en experiencias previamente realizadas por,
Grassi et al (2016). Y seis (06) videos de bacterias (Escherichia coli) obtenidos

en experiencias previamente realizadas por, Grassi et al (2019).

Variables estadisticas

Las variables estadisticas de esta investigacion estan clasificadas desde su
naturaleza y escala de medida. El fin es identificar el indicador estadistico
pertinente (Tabla 4). Dichas variables, tiempo, espacio, intensidad. Por ser una
investigacion analitica, la cual, tiene como criterio de andlisis la técnica

Bioespequelometria.
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Tabla 4. Variables estadisticas segun la naturaleza, escala de medida e

indicadores estadisticos

Variables Tipo de variable Escala de medida Indicador

Cualitativa Cuantitativa Nominal Ordinal Intervalo | Razén estadistico

Discreta | continua

Tiempo X X Coeficiente de
determinacion
que indica el
ajuste a una

tendencia

Espacio X X Coeficiente de
determinacion
que indica el
ajuste a una

tendencia

Intensidad X X Coeficiente de
determinacion
que indica el
ajuste a una

tendencia

(Molina O., 2020).

Metodologia de la Investigacién

Recoleccién de Datos

Se identificacion y organizaron los videos obtenidos por Bioespequelometria
en experiencias previas, de muestras de laboratorio de E. coli y T. cruzi, para
ello, se realizaron las Tablas 5 y 6, donde se organiz6 la informacion. Los
videos estan ubicados en pares tal como debe ser la comparacion con y sin

microorganismos, a un mismo tiempo.
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Videos de parésitos

Se conté con cuatro (04) videos de parasitos obtenidos en experiencias

previamente realizadas por, Grassi et al (2016). Los cuatro (04) videos

corresponden a dos tiempos en minutos (t0 y t15). Cada uno corresponde con

un pozo de la placa de VDRL que contiene lo que se explica en la Tabla 5.

Tabla 5. Videos de parasitos (Trypanosoma cruzi)

MO. _de Ident. del Medio  Medio Conc. de NUumero Tiempo
estudio y experimento de +MO. arasitos devideo (min.)
condicién b cultivo b '

T. cruzi Spck 9 - 100 4E0S 14 TO

(con parasios) par/ml
_T.cruzi Spck 9 100 - - 18 T0
(sin parasitos)
T. cruzi Spck 9 - 100 4E05 20 T15
(con parasitos) par/ml
T. cHiA Spck 9 100 - 1 24 T15

(sin parasitos)

Nota. MO.: microorganismo, Ident.: identificacion, Conc.: concentracion, par.: parasitos, Min.:
minutos.

Condiciones en las que se realizo el experimento de parasitos

El sistema de imagen laser Bioespeckle consistié en un laser He-Ne de 1
mW (no polarizado) que funciona a 632.8 nm que esta acoplado a un lente
convexo divergente para formar un punto de aproximadamente 10 mm en
pozos individuales en la placa VDRL.

El laser se encontraba a una distancia de 50 cm y el haz tuvo un angulo de
incidencia de 72°. Ya que los pozos tenian un diametro interno de 12.7 +/- 0.1
mm y el rayo laser crea un punto que tiene un didmetro maximo de 10 mm, el
haz ilumina el centro del pozo evitando asi efectos de borde. La placa VDRL
se coloco encima de un carton negro opaco fijado en una mesa con sistema

antivibraciones. El sistema contd con una camara CCD (Thorlabs USB.2, 30
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fps, 6.45 ym Square Pixels) que se encontraba a 30 cm de la muestra,
conectada a una PC que graba videos de 0.5—-1 min.

La resolucion de la camara fue de 1280 x 1024 pixeles, y su sistema optico
consta de distancias focales fijas de 3.5—75 mm con apertura maxima de hasta
f / 0.95, asi como una lente con zoom de 18-108 mm f / 2.5. de altura. Las
lentes de aumento estén formadas por un sistema modular que presenta un
aumento de 0.07 a 28.

Los datos de video con motas se enviaron a la computadora para el
procesamiento de video e imagen. Con esta configuracion, la region iluminada
ocupa completamente la imagen de forma homogénea, de manera que toda la

imagen esté sujeta a analisis y procesamiento (Grassi et al, 2016).
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Videos de bacterias

Se contd con seis (06) videos de bacterias obtenidos en experiencias
previas realizadas por, Grassi et al (2019). Los seis (06) videos corresponden
a tiempo 15min. Cada uno corresponde con un pozo de la placa de VDRL que
contiene lo que se explica en la Tabla 6.

Tabla 6. Videos de bacterias (Escherichia coli)

MO de Medio Medio Conc Nacl  Conc NUmero Tiempo

estudio y de + MO  Atb. ' X de video

L ; Antb. (ug) de MO. . :
condicién  cultivo video (min)

L 7,63E- Cipro
E. coli _(sm 95 » 5 04 _ T15
bacterias)

ug/ml 1

E. coli (con s> 1,5E08 Cipro

) - 95 5 04 - T15
bacterias) bact/ml

ug/ml 2

Control 1
Cipro (sin 100 - . . . COT“" T15
bacterias)
Control 3
Cipro (con -- 100 -- -- -- éa?:ltzlcrﬁ Cogtrol T15
bacterias)
Control 2 Control
Cipro (sin 95 -- -- -- 5 5 T15
bacterias)
Control 4
Cipro (con . 95 . . 5 éi'f/?ﬁ COTO' T15
bacterias)

Nota. MO.: microorganismo, Ident.: identificacion, Ath.: antibiético, Conc.: concentracion,

min.: minutos, bact.: bacterias.
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Condiciones en las que se realizo el experimento de bacterias

El sistema de imagen laser Bioespeckle contd con un laser no polarizado
He — Ne de 1 mW que funciona a 632.8 nm.

El laser se encontraba a una distancia de 50 cm, acoplado a una lente
divergente convexa y el haz forma un punto de 10 mm en los pocillos
individuales de la placa VDRL, con un angulo de incidencia de 72 °. Dado que
los pozos tienen un didmetro interno de 12.7 £ 0.1 mm, el haz ilumina el centro
del pozo de la placa VDRL que descansa sobre un carton negro opaco,
evitando destellos y efectos de borde, que a su vez descansan sobre una mesa
antivibraciones. Una camara CCD (Thorlabs USB.2, 30 fps) se encuentra a
30 cm de la muestra y es conectado a una PC que graba videos de 0.5-1min.

La resolucion de la camara es 320 x 240, tamario de pixel 6.45 pum, moteado
tamafo aprox. 21,6 um. Los datos de video Speckle se envian a una
computadora para procesamiento de video e imagen. Para visualizar una
cantidad significativa de bacterias por pixel, una cantidad relativamente baja,

se eligio la resolucion para la camara (Grassi et al, 2019).
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Procesamiento de Datos
Estos videos fueron fragmentados en fotogramas, usando el programa
DVDVideoSoft Studio. En la Tabla 7, se muestra el nGmero total de fotogramas

de cada video, el tiempo de duracion y el valor de Fotogramas/segundo (fps)

Tabla 7. Separacién de videos en fotogramas

_ _ Duracion Foto/segundo
Experimento Video Fotogramas totales

(Segundos) (Fps)

1 773 31 24,93

Control 2 771 31 24.87
Cipro 3 783 31 25,25

4 775 31 25,00

cobiod 18 1512 60 25,20
T cruzi 24 2.375 95 25,00
1 762 30 25,40

Speckle Olga 2 763 30 25,43
Cipro 3 763 30 25,43

4 770 31 24,83

T. cruzi 14 1.522 61 24,95
Speckle 9 20 1.512 60 25,20
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Procedimiento de Tendencia Espacial

Procesamiento directo

Utilizando el programa ImageJ, se seleccioné un video y se procedi6 de la
siguiente manera: File>Open>Seleccionar Fotograma (#100)>Edit>
Seleccion>Specifity>Ancho:320>Alto:1 Pixel> X:1>Y:200>0OK>Image>Cro>
Anallize>Plop Profile>List>Edit>Copy>Abrir Excel>Pegar en Excel. De esta
manera se obtuvieron los valores de intensidad para una linea de pixeles X:

320, cuya resolucién es de 320x240 pixeles.

Seleccién de las semi elipses

Luego usando Excel, esa linea de pixeles se grafic6 completa colocando
namero de pixel (variable independiente) vs intensidad (variable dependiente).
Luego se seleccionaron regiones que correspondieran a picos que tuvieran un
buen ajuste a una tendencia polinomial. En todos los casos se ajusté a una
ecuacion polinomica de segundo grado y se obtuvo el coeficiente de
determinacion (R?). Para la seleccion de las regiones se tomaron en cuenta
los siguientes criterios: semi elipses que formaran picos simétricos, con mas
de tres (03) puntos y cuyas ecuaciones tuvieran un R2 de 0,9 o superior.

Se seleccionaron regiones similares (mismo rango de pixeles) para el par
de videos con y sin microorganismos. De cada ecuacion se tomd en cuenta el
coeficiente de x2, y se calculé el promedio, la desviacion estdndar y el
coeficiente de variacién en cada caso. Se llevaron a una tabla y se compararon

por pares con la misma condicion, pero con y sin microorganismos.
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Célculo del area de las semi elipses

Se realizo el calculo del &rea de las semi elipses de acuerdo con la ecuacion:

A = abm/2. Donde A es area, y a 'y b son los radios de la elipse.

Procesamiento con separaciéon en canales o

bandas de colores (sistema RGB)

Utilizando el programa ImageJ, se selecciond un video y se procedio de la
siguiente manera: File> Open> Seleccionar Fotograma (#100) > Image>
Color> Split Channel > Red> Edit > Seleccion> Specifity> Ancho:320> Alto: 1
Pixel> X:1> Y:200> OK> Image>Cro> Anallize> Plop Profile> List> Edit>
Copy> Abrir Excel> Pegar en Excel. De alli en adelante, se siguid la misma
metodologia descrita para la seleccion de las semi elipses.

Procedimiento de Tendencia Temporal

Para la tendencia temporal se utilizé el programa SAGA GIS para obtener
las medidas repetidas en el tiempo de un pixel previamente seleccionado, X:
303 y Y:120, para el cual se obtuvieron 250 valores a partir del fotograma
namero 100. Estas medidas repetidas en el tiempo se procesaron de dos
maneras.

Primero, se extrajeron sectores para obtener la tendencia polinémica de
segundo orden, siguiendo la misma metodologia descrita para la seleccién de
las semi elipses en la tendencia espacial, obteniendo también, el promedio, la
desviacién estandar y el coeficiente de variacion para el coeficiente del término
x?. Sin embrago, se considero6 que es un método subjetivo, por lo que se buscd

una manera mas objetiva y cuantitativa de hacerlo. Para ello se utilizd el
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segundo método en el cual se calculd el promedio de intensidad de un pixel
en el tiempo (coordenadas, X: 303, Y:120), desviacidn estandar y coeficiente
de variacién de los datos de cada video en pares de comparacion como se

venia realizando anteriormente.

Disefio de andlisis de los datos

Los resultados de esta investigacion fueron analizados a través del enfoque
cuantitativo. Tal como lo propusieron Palella y Martins (2010), se recolectaron
los datos relacionados con el problema de investigacion, se analizaron
matematicamente, en Microsoft Excel 2017. Se hicieron comparaciones de los
términos variables y de graficos que representan cada uno de los fenémenos.
El andlisis descriptivo de los resultados se llevo a cabo a través de
comparaciones de los términos variables en tablas y graficos que representan

cada uno de los fendmenos.
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CAPITULO IV

RESULTADOS Y DISCUSION

Separacion en Fotogramas

Todos los videos presentan alrededor de 25 fps, por lo que la velocidad de

toma del video es constante y no parece ser una variable interviniente.

Tendencia Espacial

Tendencia Espacial por el Método Directo

(sin separar en bandas de colores)

Para la extraccion de datos se usaron los programas, DVD video Soft Free
Studio, el cual permite separar videos en fotogramas, y el programa ImageJ,
para obtener de cada fotograma, una linea de pixeles con valores de
intensidad para cada uno. Usando las coordenadas X=1, Y: 220 (ancho de la
linea: 320 pixeles, alto de la linea: 1 pixel), de cada linea completa, se obtuvo
el valor de intensidad para cada pixel. Estos valores se graficaron en Excel y
se seleccionaron regiones con buen ajuste a una ecuacion polindmica de
segundo orden y cuidando que las regiones tomadas en cada caso, fueran
similares para la condicién con microorganismos y sin microorganismos.

A continuacion, en la Tabla 8, se muestran los resultados obtenidos para los

videos de pozos que contienen parasitos y sus controles sin parasitos.
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Tabla 8. Resultados de tendencia espacial por el método directo en

parasitos (T. cruzi).

VIDEO ESCALA ECUACION R2
197-202 y =-40.179x2 + 2E+07x - 2E+09 R2 =0,9482
VIDEO 18 224-227 y = -86.666x2 + 4E+07x - 4E+09 Rz =0,982
(sin 228-231 y =-111.667x2 + 5E+07x - 6E+09 Rz=1
parasitos) 268-271 y =-70.000x2 + 4E+07x - GE+09 R = 0,0841
Promedio: 77.128 DE: 30.000 CV: 39
150-156 y = -46.349x2 + 1E+07x - 1E+09 R2 =0,9898
176-179 y =-16.0834x2 + 6E+07x - 5E+09 R2=0,9392
VIDEO 14
278-282 y =-53.571x2 + 3E+07x - 4E+09 R2 =0,9867
par(gs?i?os) 288-291 y = -57.500%x2 + 3E+07x - 5E+09 R2 = 0,9969
Promedio: 79.564 DE: 54.377 CV: 68
Relacién con y sin microorganismo: 1,75
106-109 y =-110.000x2 + 2E+07x - 1E+09 R? =0,9996
VIDEO 24 122-125 y =-83.333x2 + 2E+07x - 1E+09 Rz =0,9092
(sin 183-186 y =-95.833x2 + 4E+07x - 3E+09 R2 =0,9755
parasitos) 296-299 y = -85.833x2 + GE+07x - 8E+09  R2 = 0,9958
Promedio: 93.750 DE: 12.105 CvVv: 13
130-134 y =-86.905x2 + 2E+07x - 2E+09 R2=0,9703
VIDEO 20 146-149 y =-80.834x2 + 2E+07x - 2E+09 Rz=1
(con 196-200 y =-84.286x2 + 3E+07x - 3E+09 R2 =0,9668
parasitos) 230-236 y =-33.532x2 + 2E+07x - 2E409  R2=0,9144
Promedio: 71.389 DE: 25.360 CV 36
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Relaciéon con y sin microorganismo: 2,75
Nota: DE: Desviacién estandar, CV: coeficiente de variacion.

En la tabla 8, se comparoé el video 18 (sin parasitos) con el video 14 (con
parasitos) observamos que el promedio del coeficiente del primer término de
la ecuacion del primer video es menor, siendo 77.128 para el primer video y
79.564 para el segundo video, a su vez presenta mayor variabilidad en los
datos el video que contiene parasitos, con respecto al que no los contiene,
presentandose una relacion de variacion de 1,75 entre los coeficientes.

Como se puede observar, el coeficiente de variacion si expresa la relacion
esperada ya que éste es mayor para el video que contiene parasitos. Este
coeficiente ha sido utilizado por otros autores como descriptor de moteado de
Speckle y ha sido denominado Contraste Temporal ya que es aplicado a
medidas repetidas en el tiempo (Sendra, 2010). En este caso, hemos aplicado
el Contraste Temporal a una secuencia espacial obteniendo el resultado
esperado.

Este descriptor que relaciona la desviacion estandar con el promedio de la
intensidad, es una medida de la variabilidad con menor énfasis en los valores
absolutos de intensidad. Esto es interesante debido a que en estos ensayos la
intensidad del laser puede no ser constante debido a variaciones en la
corriente eléctrica o al tiempo de uso del laser. Sin embargo, este descriptor
puede descubrir una diferencia entre videos, aunque sea pequefia.

En la comparacion del video 24 (sin parasitos) con el video 20 (con
parasitos), se observé que el promedio del coeficiente del primer término de la
ecuacion del primer video es mayor, siendo 93.760 para el primer video y
71.389 para el segundo video, sin embrago, presenta mayor variabilidad en
los datos el video que contiene parasitos, con respecto al que no los contiene.

Nuevamente el coeficiente de variacion expresa la relacion esperada, siendo
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mayor para el video 20 que contiene parasitos y arrojando una relaciéon de
2,75.

De esta manera, el coeficiente de variacion puede ser el descriptor que
mejor exprese la relacion buscada, siendo éste 1,75y 2,75 respectivamente
para la presencia de parasitos en comparacién con el video que no los
contiene.

A continuacion, en la tabla 9, se muestran los resultados obtenidos para los

videos de pozos que contienen bacterias y sus controles, sin bacterias.

Tabla 9. Resultados de tendencia espacial por el método directo en
Bacterias (E. coli)

VIDEO ESCALA ECUACION R2
188-192 y = -125.714x2 + GE+07x - GE+09  R? = 0,9378
VIDEQ 192-197 y = -93.214x2 + AE+07x - 4E+09  R2=0,9303
CiP1 230-235 y = -65.893x2 + 3E+07x - 4E+09  R2 = 0,9544
(sin 272-275 y =-120.000x2 + 7E+07x - 9E+09  R?=0,9741
bacterias)
Promedio: 101.205 DE: 27,54 CV: 27
109-112 y = -182.500x2 + 4E+07x - 2E+09  R? = 0,9695
- = . - 2 =
VIDEO 219-222 y =-135.000x2 + 6E+07x - TE+09  R? = 0,9496
cip o 249-252 y = -70.000%2 + 4E+07x - 4E+09 R2 = 0,954
(con 264-267 y = -50.000x2 + 3E+07x - 4E+09  R?=0,9936
bacterias) o edio: 109.375 DE: 60.772 CV: 56

Relacion con y sin microorganismo: 2,06

- =- - 2 =
VIDEO 147-150 y =-152.500x2 + 5E+07x - 3E+09 Rz = 10,9866

- =- - 2 =
CONTROL 157-160 y =-147.500x2 + 5E+07x - 4E+09 R2=0,9972
1 168-171 y =-145.000x2 + 5E+07x - 4E+09 R2 =0,9052
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(sin
bacterias)

VIDEO

CONTROL
3

(con
bacterias)

VIDEO

CONTROL
2

(sin
bacterias)

VIDEO

CONTROL
4

(con
bacterias)

207-210

Promedio: 135.000

141-144

145-148

148-153

209-213

Promedio: 74.911

Relacién con y sin microorganismo: 1,95

184-188

212-216

217-220

223-227

Promedio: 70.625

149-152

168-174

222-226

255-261

Promedio: 71.399

Relacién con y sin microorganismo: 1,87

y =-95.000x2 + 4E+07x - 4E+09
DE: 26.848

y =-62.500x2 + 2E+07x - 1E+09

y =-117.500x2 + 3E+07x - 3E+09

y =-67.500x2 + 2E+07x - 2E+09

y =-52.143x2 + 2E+07x - 2E+09

DE: 29.104

y =-75.000x2 + 3E+07x - 3E+09
y =-55.000x2 + 2E+07x - 3E+09
y =-52.500x2 + 2E+07x - 3E+09
y =-100.000x2 + 4E+07x - 5E+09
DE: 22.020
y =-117.500x2 + 4E+07x - 3E+09
y =-67.381x2 + 2E+07x - 2E+09
y =-83.571x2 + 4E+07x - 4E+09
y =-17.143x2 + 9E+06x - 1E+09

DE: 41.766

R2 =0,9957
CvV: 20
R2=0,9499
R2 =0,9928
R2=0,9216
R2=0,9512

Cv: 39

R2=0,942
R2=0,9897
R2=0,9813

R2=0,996

Cv: 31
R2=0,9428
R2=0,9671

R2=0,948

R2=0,9246

CV: 58

Nota: DE: Desviacion estandar, CV: coeficiente de variacion.

En la tabla 9, se comparé el video CIP 1 (sin bacterias) con el video CIP 2

(con bacterias), el video control 1 (sin bacterias) con el video control 3 (con

bacterias),

el video control 2 (sin bacterias) con el video control 4 (con

bacterias), observandose que para todos los casos la desviacion estandar y el

coeficiente de variacion es mayor para el video que contiene bacterias, lo que
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indica que los datos de estos videos presentan mas variabilidad, mientras que
los datos de los videos que no contienen bacterias son mas homogéneos con
respecto a la media.

Es de notar que en todos los casos en que se comparan videos con y sin
bacterias, el coeficiente de variacion ha resultado ser el mejor descriptor para
detectar la presencia de bacterias y esto coincide también con los videos en
presencia y ausencia de parasitos. Aunque este descriptor es la misma
expresion que el contraste temporal, lo seguimos denominando coeficiente de
variacion debido a que en este caso se aplica a una relacién espacial y no
temporal.

En los tres pares de ensayos con bacterias, en la relacion con/sin bacterias,
las relaciones de los coeficientes de variacion son 2,06; 1,95 y 1,87
respectivamente. Mientras que, para parasitos estas relaciones son 1,75 y
2,75; indicando que este descriptor, si bien puede distinguir la presencia y
ausencia de microorganismos, no es indicativo de las dimensiones de los

mismos.

Resultados de Tendencia Espacial

(separando en bandas de colores)

RGB es el acrénimo inglés de rojo, verde y azul. Es un modelo de color en
el cual es posible representar un color, mediante la mezcla por adicion de los
tres colores primarios.

La separacion en bandas o canales RGB es el tratamiento de la sefial
de video que trata por separado las sefiales de los tres colores rojo, verde y
azul. Al usarlo independientemente, proporciona mayor calidad y reproduccién
mas fiel del color. De esta forma no hay pérdidas en el tratamiento de laimagen
puesto que los colores primarios siguen existiendo como tal en su transmision.

Por el contrario, mediante este sistema hay mucha informacion redundante,
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con el consiguiente aumento del ancho de banda necesario respecto a otros
métodos de transmisién. Por ejemplo, cada color lleva el valor de brillo de toda
la imagen, de forma que esta informacién esta por triplicado (Gonzales y
Woods, 1996).

A continuacion,en la tabla 10, se muestran los resultados de tendencia
espacial obtenidos para la banda o canal rojo, luego de separar en bandas de
colores, para los videos de pozos que contienen parasitos y sus controles, que

no los contienen.

Tabla 10. Resultados de tendencia espacial de la banda roja en

parasitos (T. cruzi)

VIDEO RANGO ECUACION,M R?
197-202 y = -4,2857x2 + 1711,7x — 170754  R2 =0,9658
VIDEQ/T¥ 212-218 y = -3,0833x2 + 1325,9x — 142391  R2=0,904
Split channels 224-227 y = -8,5x2 + 3833,7x — 432128 R? = 0,9938
(sin i _ 5
bardsitos) 252-255 y =-10,25x2 + 5197,5x — 658752  R2=0,9999
Promedio: 6,53 DE: 3,40 CV: 52,04
150-156 y = -4,8214x2 + 14752x — 112679  R2 =0,9889
VIDEO 14 180-184 y = -7.0286x2 + 2881,7x — 261685  R2 = 0,9567
Split channels 261-264 y =-10,75x2 + 5644,1x — 740713 R2 = 0,9999
(con i _ B 9
bardsitos) 278-282 y = -5,3571x2 + 2998,5x — 419511  R2 = 0,9867
Promedio: 7,21 DE: 2,72 CV: 37,70
Relacion 0,72
108-111 y = -11x2 + 2407,4x — 131563 R2 = 0,9996
VIDEO 24
127-130 y = -4,25x2 + 1092,1x — 70043 R2 = 0,9938
Split channels
253-256 y = -4,75x2 + 2417x — 307386 R2 = 0,9581
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(sin 278-281 y = -6,5x2 + 3632,9x — 507536 R2 =0,9596
parasitos)

Promedio: 6,88 DE: 2,90 CV: 42,25
115-118 y = -7x2 + 1630,4x — 94791 R2 = 0,0243
VIDEOG 20 131-135 y = -8,8571x2 + 2356,8x — 156604 R = 0,9766
Split channels 197-201 y = -8,5714x2 + 3409x — 338805  R2 = 0,9639

(con ) _ _ 5 _
pardsitos) 231-237 y = -3,3452x2 + 1565x — 182898  R2=0,9143
Promedio: 6,94 DE: 2,53 CV: 36,49

Relacion 0,86

Nota: Split channels: separado en bandas de colores, DE: Desviacion estandar, CV:

coeficiente de variacion.

En latabla 10, se muestra la comparacion de videos, previamente separados
en bandas de colores (color seleccionado: rojo). Se compar6 el video 18 (sin
parasitos) con el video 14 (con parasitos), y el video 24 (sin parasitos) con el
video 20 (con parasitos). Se observo que los promedios de los coeficientes del
primer término de la ecuacion, son mayores para los videos que contienen
parasitos, mientras que, la variabilidad en los datos es mayor para los videos
gue no contienen parasitos, comportamiento contrario al esperado.

Para poder comparar los videos que contienen parasitos con los que
contienen bacterias, se procesaron estos ultimos de la misma manera en que
se procesaron los de parésitos, es decir, separando en bandas de colores. A
continuacion, en la tabla 11, se muestran los resultados de tendencia espacial
obtenidos separando en bandas de colores, para los videos de pozos que

contienen bacterias y sus controles que no las contienen.
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Tabla 11. Resultados de tendencia espacial de la banda roja en

bacterias (E. coli)

VIDEO RANGO ECUACION R2
110-113 y = -25,25x2 + 5634,7x — 314179  R2= 0,966
) y = -12,571x2 + 4774,3% — .
188-192 453204 R2 =0,9378
VIDEO CIP 1
Split channels _ _
192-197 y =-9,3214x2 + 3625,7x R? = 0,9303
. . 352468
(sin bacterias)
) y = -6,5893x2 + 3065,8X — ,_
230-235 356540 Rz = 0,9544
Promedio: 13,43 DE: 8,25 CV: 61,41
105-108 y = -18,25x2 + 3886,5x — 206784  R2 = 0,9695
201-205 y = -8x2 + 3247,2x — 329425 Rz = 0,933
VIDEO CIP 2
Split channels 215-218 y =-13,5x2 + 5844,1x — 632386  R2 = 0,9496
(con bacterias) 245-248 y = -7x2 + 3449,8x — 425004 R2 = 0,954
Promedio: 11,66 DE: 5,21 CV: 44,71
Relacion 0,72
155-158 y =-14,75x2 + 4616,8x — 361133  R2=0,9972
VIDEO _ _
CONTROL 1 176-179 y = -22,25x2 + 7892,1x — 699712  R2 = 0,9901
. 205-208 y =-9,5x2 + 3920,3x — 404378  R2=0,9957
Split channels
- =- — 2 =
(sin bacterias) 242-246 y = -8x2 + 3905,6x — 476626 R2 =0,9011
Promedio: 13,63 DE: 6,44 CV: 47,25
VIDEO y = -7,2143x2 + 1830,1x — .
CONTROL 3 125-129 115919 R?=0,943
Split channels 149-154 y = -6,75x2 + 2043,2x — 154485 Rz =0,9216
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(con bacterias)

VIDEO control
2 Split
channels

(sin bacterias)

VIDEO control
4 Split
channels

(con bacterias)

y =-4,4821x2 + 1661,6x —

183-188 153879
210-214 y= -5,214f2?é>i12145r72210,4x -
Promedio: 5,92 DE: 1,28
Relacion 0,46
137-140 y =-18,5x2 + 5128,3x — 355245
186-190 y =-7,5x2 + 2822,1x — 265366
214-218 y =-5,5x2 + 2375,7x — 256470
233-238 y= -5,32122221;12502,& -
Promedio: 9,21 DE: 6,27
132-135 y =-18,25x2 + 4874,1x — 325295
149-152 y =-11,75x2 + 3533,6x — 265556
163-166 y =-12x2 + 3950,6x — 325065
999-996 y= -8,357411225;63740,9x -
Promedio: 12,59 DE: 4,12
Relaci6n 0,48

R2 =0,9647

R2=0,9512

CV: 21,67

Rz =0,957
R2=10,942

R2 =0,9897

R2 =0,9556

CV: 68,16
R2=0,9178
R2=0,9428

R2=0,9225

R2=0,948

CV: 32,75

Nota: Split channels: separado en bandas de colores, DE: Desviaciéon estandar, CV:

coeficiente de variacion.

En la tabla 11, se comparo el video CIP 1 (sin bacterias) con el video CIP 2
(con bacterias), el video control 1 (sin bacterias) con el video control 3 (con
bacterias), el video control 2 (sin bacterias) con el video control 4 (con

bacterias), observandose que la desviacion estandar y el coeficiente de

variacion del

video con bacterias, es menor en todos

comportamiento contrario al esperado.
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El hecho de que en este caso no se cumpla la relaciébn esperada del
coeficiente de variacion podria explicarse porque, es posible que la separacion
en bandas conduzca a la pérdida de informacion o visto desde otro punto de
vista, que sea necesaria la informacion redundante como ocurre en el
procesamiento directo con las tres bandas de colores, para detectar un
fendmeno de tan baja intensidad como es el Bioespeckle.

Finalmente, para concluir el andlisis espacial, se calcul6 el area de la semi
elipse dibujada por los picos y de acuerdo con la formula:

A =abm/2
Donde a y b son los dos radios de la elipse. Se obtuvieron los valores que se

muestran en la tabla 12.

Tabla 12. Comparacion de areas del semi elipse

AREA DEL SEMI AREA DEL SEMI
VIDEO ELIPSE (SIN SPLIT ELIPSE (CON
CHANNEL) SPLIT CHANNEL)
Cip1l 2.243.137,50 249,43
Cip 2 855.650,00 112,84
Relacioén: 0,38 0,45
Control 1 1.044.050,00 132,08
Control 3 1.171.612,50 156,80
Relacioén: 1,12 119
Control 2 765.375,00 154,84
Control 4 1.795.687,50 129,53
Relacioén: 2,35 0.84
Video 18 792.848,82 109,51
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Video 14 1.308.987,30 143,46

Relacioén: 1,65 131
Video 24 785.000,00 48,67
Video 20 1.354.974,96 136,20
Relacioén: 1,73 2,80

Considerando el &rea de las semi elipses, se encuentra una buena relacion,
en general mayor que 1,00 para la comparaciéon con microorganismos/sin
microorganismos. Adicionalmente, si no se toman en cuenta los valores
extremos (>2 y <1), se encuentra que la relacion de areas de las semi elipses
con y sin bacterias dan valores de 1,12 y 1,19, mientras que la relacion de
areas de las semi elipses con y sin parasitos, dan valores de 1,65; 1,73y 1,31.
Este constituye un descriptor que pudiera estar estableciendo, no solamente
la presencia de microorganismos, sino también la diferencia en dimensiones

entre bacterias y parasitos.

Tendencia Temporal

En la tendencia espacial, debido a que se considera un fotograma que es
una foto en un tiempo determinado, se toma en cuenta el Bioespeckle
producido por diferentes unidades de microorganismos en espacios diferentes.
Es por ello que el valor de los coeficientes arrojados en este analisis, debe
mostrar gran variabilidad. Por otra parte, en la tendencia temporal, el
Bioespeckle producido podria pertenecer a una misma unidad de
microorganismo que se mueve en el tiempo, siendo esta tendencia
representativa del movimiento del microorganismo. Es de esperar que los

microorganismos mas pequefios se muevan mas que los microorganismos

44



mas grandes por lo que se espera que los mas pequenfios (bacterias) presenten
mayor variabilidad que los mas grandes (parasitos).
En las Tablas 13y 14, se muestra la tendencia polindmica de segundo orden

de los picos en una serie temporal en videos de parasitos y bacterias.

Tabla 13. Resultados de tendencia temporal en parasitos (T. cruzi)

VIDEO RANGO ECUACION R2
106-109 y = -151.237x2 + 3E+07x - 2E+09 R2=0,9748
111-114 y = -198.797x2 + 4E+07x - 3E+09 R2=0,9479
T. Cruzi 180-183 y =-122.119x2 + 4E+07x - 4E+09 Rz2=1
VIDEO 18
(sin 239-242 y = -116.688x2 + 6E+07x - 7E+09 R2 = 0,9827
parasitos) 253-256 y =-236.007%2 + 1E+08x - 2E+10 = R2 = 0,0448
287-291 y = -80.546x2 + S5E+07x - TE+09 R2 = 0,9529
Promedio:
DE: 57.421 cv: 38
150.899
145-149 y = -106.663x2 + 3E+07x - 2E+09 R2 = 0,9879
200-203 y = -91.678x2 + 4E+07x - 4E+09 R2=0,998
_ 222-225 y = -155.435x2 + 7E+07x - 8E+09 R2 = 0,9999
T. Cruzi
VIDEO 14 269-272 y = -148.456x2 + 8E+07x - 1E+10 R2 = 0,9957
(con
parasitos) 272-275 y = -94.706x2 + S5E+07x - 7E+09 R2 = 0,9857
282-285 y = -174.845x2 + 1E+08x - 1E+10 R2=0,985
Promedio:
DE: 35.344,71 CV:- 27
128.631

Relacién con/sin parasitos: 0,72
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T. Cruzi
VIDEO 24
(sin

parasitos)

T. Cruzi
VIDEO 20
(con

parasitos)

121-125

179-182

184-188

218-221

236-239

304-307
Promedio:
100.333

112-118

123-127

218-221

267-270

279-284

297-301
Promedio:
171.666

y =-111.093x2 + 3E+07x - 2E+09

y =-66.676x2 + 2E+07x - 2E+09

y =-39.198x2 + 1E+07x - 1E+09

y =-123.554x2 + 5E+07x - 6E+09

y =-124.405x2 + 6E+07x - 7TE+09

y =-137.071x2 + 8E+07x - 1E+10

DE: 38.612

y =-62.275x2 + 1E+07x - 8E+08

y =-200.453%x2 + 5E+07x - 3E+09

y =-254.018x2 + 1E+08x - 1E+10

y =-228.981x2 + 1E+08x - 2E+10

y =-134.544x2 + 8E+07x - 1E+10

y =-149.724x2 + 9E+07x - 1E+10

DE: 70.316

Relacién con/sin parasitos: 1,08

R2=0,9483

R2=0,9813

R2 = 10,9683

R2=0,9991

R2=0,9369

R2=0,9702

Cv: 38

R2=0,9712

R2=0,9029

R2=0,905

R2=0,9999

R2=0,9483

R2=0,9677

Cv: 41

En la tabla 13, se comparoé el video 18 (sin parasitos) con el video 14 (con

En la comparacién del video 24 (sin parasitos) con el video 20 (con
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parasitos) observamos que el promedio del coeficiente del primer término de
la ecuacion, la desviacion estandar y el coeficiente de variaciébn es mayor para

el video que no contiene parasitos, comportamiento contrario al esperado.

parasitos), se observé que el promedio, la desviacion estandar y el coeficiente



de variacion es mayor para el video que contiene parasitos, lo que indica que
los datos de este video presentan mas variabilidad, mientras que los datos del

video que no contiene parasitos son mas homogéneos con respecto a la

media.

Tabla 14. Resultados de tendencia temporal en bacterias (E. coli)

VIDEO RANGO ECUACION R2
105-108 y = -39.750x2 + 8E+06x - 5E+08 R2=0,9979
140-143 y = -28.784x2 + 8E+06x - 6E+08 R2 =0,9999
- = - - 2 =
VIDEO CIP 219-222 y =-67.164x2 + 3E+07x - 3E+09 R2=0,9918
01 241-244 y =-59.853x2 + 3E+07x - 4E+09 R2=0,9994
(sin
bacterias) 282-285 y =-30.612x2 + 2E+07x - 2E+09 R2 =0,9836
304-307 y = -28.784x2 + 2E+07x - 3E+09 R2=0,9999
Promedio:
DE: 16.939 CV: 40
42.491
102-105 y =-121.077x2 + 3E+07x - 1E+09 R2=0,9988
146-149 y =-22.845x2 + 7E+06x - 5E+08 R2=1
161-164 y =-72.646x2 + 2E+07x - 2E+09 R2 =0,9994
VIDEO CIP
02 194-197 y =-79.043x2 + 3E+07x - 3E+09 R2=0,9999
(con
bacterias) 224-227 y =-55.741x2 + 3E+07x - 3E+09 R2=0,9917
294-297 y =-32.911x2 + 2E+07x - 3E+09 R2=0,993
Promedio:
DE: 35.4611 CV: 55
64.044
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CONTROL
01
(sin

bacterias)

CONTROL
03
(con
bacterias)

CONTROL
02
(sin

bacterias)

Relaciéon CV con/sin microorganismos: 1,38

100-103

110-113

202-205

217-220

286-290

316-320

Promedio:

25.010

117-120

129-132

134-137

181-184

227-230

262-265

Promedio:

46.908

y =-24.672x2 + 5E+06x - 3E+08

y =-31.069x2 + 7E+06x - 4E+08

y =-21.474x2 + 9E+06x - 9E+08

y =-30.155x2 + 1E+07x - 1E+09

y =-14.621x2 + 8E+06x - 1E+09

y = -28.066x2 + 2E+07x - 3E+09

DE: 6.214

y =-97.319x2 + 2E+07x - 1E+09

y =-43.862x2 + 1E+07x - 7TE+08

y =-28.784x2 + 8E+06x - 5E+08

y =-32.440x2 + 1E+07x - 1E+09

y =-53.457x2 + 2E+07x - 3E+09

y =-25.586x2 + 1E+07x - 2E+09

DE: 26.780

Relaciéon CV con/sin microorganismos: 2,30

136-139

178-182

196-199

y =-46.146x2 + 1E+Q07x - 9E+08

y =-44.906x2 + 2E+07x - 1E+09

y =-54.827x2 + 2E+07x - 2E+09

R2=0,9881

R2 =0,9998

R2? =0,9932

R2=0,9998

R2=0,917

R2=0,9573

Cv: 25

R2=0,9937

R2=0,9889

R2=0,9999

R2 =0,9969

R2 =0,9848

R2=0,999

CV: 57

R2=0,9891

R2=0,905

R2 =0,9995
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CONTROL
4
(con

bacterias)

234-237

266-269

301-304

Promedio:

39.543

134-138

182-187

196-199

210-213

264-267

295-298

Promedio:

24.884

y =-26.500x2 + 1E+07x - 1E+09

y =-34.267x2 + 2E+07x - 2E+09

y =-30.612x2 + 2E+07x - 3E+09

DE: 10.804

y =-14.098x2 + 4E+06x - 3E+08

y =-17.329x2 + 6E+06x - 6E+08

y =-23.302x2 + 9E+06x - 9E+08

y =-24.672x2 + 1E+07x - 1E+09

y =-18.276x2 + 1E+07x - 1E+09

y =-51.629x2 + 3E+07x - SE+09

DE: 13.674

Relacién CV con/sin microorganismos: 2,04

R2=0,9991

R2=0,9972

Rz2=1

CV: 27

R2=0,9691

R2=0,978

R2=0,9632

R2 = 0,9697

R2=0,9988

R2=0,9047

CV: 55

En la tabla 14, se comparé el video CIP 1 (sin bacterias) con el video CIP 2
(con bacterias), el video control 1 (sin bacterias) con el video control 3 (con
bacterias), el video control 2 (sin bacterias) con el video control 4 (con
bacterias), observandose que la desviacion estandar y el coeficiente de
variacion del video con bacterias, es mayor en todos los casos lo que indica
que los datos de este video presentan mas variabilidad, mientras que los datos

del video que no contiene bacterias son mas homogéneos con respecto a la

media.
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Se observa que la tendencia temporal puede ser un buen descriptor para
detectar la presencia de microorganismos. Adicionalmente, se puede observar
que la relacion del coeficiente de variacidbn es mayor para los videos que
contienen bacterias en comparacion con los que contienen parasitos.

Si se toma en cuenta que la tendencia temporal est4d evaluando
principalmente el movimiento de los microorganismos, es de esperar que la
relacion del coeficiente de variacibn sea mayor para bacterias que para
parasitos, como se obtiene en este resultado. Esto es de esperar porque las
bacterias tienen un movimiento mas rapido que los parasitos y una
combinacion de movimiento bacteriano y movimiento browniano, por lo que

este resultado es el esperado.

Descriptores estadisticos en videos con bacterias

A continuacion, se presentan los graficos completos de las medidas
repetidas en el tiempo o serie temporal para cada video, se colocé como
variable independiente el nimero de fotogramas, que a su vez es una
representacion del tiempo transcurrido ya que se tomara un fotograma cada
0,04 segundos. La variable dependiente es la intensidad en unidades
arbitrarias (u.a.). Se calcularon algunos descriptores estadisticos como
promedio, desviacion estandar, coeficiente de variacion y las relaciones entre

ellos.
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Figura 1. Gréafico Video Control 01 (sin bacterias)
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Figura 2.Gréfico Video Control 03 (con bacterias)
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Tabla 15. Descriptores Estadisticos en los videos Control 01- Control 03

VIDEO CONTROL 01 VIDEO CONTROL 03
VIDEO ) . )
(sin bacterias) (con bacterias)
PROMEDIO 1.197.123 806.756
DE 235.864 95.230
Ccv 20 12
CV C 03+/C 01- 0,60
X C 03+/C 01- 0,67
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En la tabla 15, se compar6 el video control 1 (sin bacterias) con el video
control 3 (con bacterias), observandose que el promedio del video sin bacterias
es mayor que el video con bacterias, igualmente, la desviacion estandar y el
coeficiente de variaciéon es mayor para el video que no contiene bacterias, lo
que indica que los datos del video que no contiene bacterias presenta mas
variabilidad, mientras que los datos del video que contiene bacterias son mas
homogéneos con respecto a la media.

Este es un comportamiento contrario al esperado. Debido a que en otras
evaluaciones se observd este mismo comportamiento y debido a que en el
grafico de medidas repetidas en el tiempo se observa de manera evidente la
alta variabilidad en el video sin bacterias y la baja variabilidad en el video con
bacterias, pensamos que éste puede ser un error en la preparacion o

colocacioén de la muestra.
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Figura 3. Grafico Video CIP 01 (sin bacterias)
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Figura 4.Grafico Video CIP 02 (con bacterias)
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Tabla 16. Descriptores estadisticos en los videos CIP 01- CIP 02

oo R e
PROMEDIO 886.054 006.352
DE 95.220 162.359
cv 11 18
CV CIP2+/CIP1- 1,63
X CIP2+/CIP1- 1,02

53



Figura 5. Gréafico Video control 02 (sin bacterias)
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Figura 6. Grafico Video control 04 (con bacterias)
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Tabla 17. Descriptores estadisticos en los videos Control 02 - Control 04

VIDEO CONTROL 02 VIDEO CONTROL 04

VIDEO (sin bacterias) (con bacterias)
PROMEDIO 917.931 763.169
DE 121.933 104.702
cv 13 14
CV C 04+/C 02- 1,06
X C 04+/C 02- 0,83
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En las tablas 16 y 17, se comparoé el video CIP 1 (sin bacterias) con el
video CIP 2 (con bacterias), y el video control 2 (sin bacterias) con el video
control 4 (con bacterias), respectivamente. Observandose que el coeficiente
de variacién es mayor para el video que contiene bacterias.

El coeficiente de variacion ha sido ya utilizado por otros autores como
descriptor de moteado de Speckle, denominado Contraste Temporal y es
aplicado generalmente a medidas repetidas en el tiempo. (Sendra et al, 2010).

Este descriptor que relaciona la desviacion estandar con el promedio de la
intensidad, es una medida de la variabilidad con menor énfasis en los valores
absolutos de intensidad. Esto es interesante debido a que en estos ensayos la
intensidad del laser puede no ser constante debido a variaciones en la
corriente eléctrica o al tiempo de uso del laser. Sin embargo, este descriptor

puede descubrir una diferencia entre videos, aunque sea pequefia.
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Tendencia temporal en videos con parasitos

Figura 7. Gréafico T. cruzi Video 18 (sin parasitos)
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Figura 8. Grafico T. cruzi Video 14 (con parésitos)
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Tabla 18. Descriptores estadisticos en los Videos 18-14

T. cruzi. VIDEO 18 T. cruzi. VIDEO 14
VIDEO : oy g
(sin parésitos) (con parasitos)
PROMEDIO 4.150.020 3.573.890
DE 318.106 347.397
Ccv 8 10
CV VID 14+/V 18- 1,22
X VID 14+/V 18- 0,86
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Figura 9. Gréafico T. cruzi Video 24 (sin parasitos)
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Figura 10. Gréfico T. cruzi Video 20 (con parasitos)
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Tabla 19. Descriptores estadisticos en los Videos 24-20

T. cruzi. VIDEO 24 T. cruzi. VIDEO 20
VIDEO : g L
(sin parésitos) (con parasitos)
PROMEDIO 3.229.160 4.084.527
DE 266.722 587.250
Cv 8 14
CV VID 20+/V 24- 1,80
X VID 20+/V 24- 1,26

En la Tabla 18 y la Tabla 19, se compard el video 18 (sin parasitos) con el
video 14 (con parasitos) y el video 24 (sin parasitos) con el video 20 (con

parasitos), respectivamente. Observandose que para ambos casos la
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desviacién estandar y el coeficiente de variacion es mayor para los videos que
contienen parasitos, lo que indica que los datos de estos videos presentan mas
variabilidad, mientras que los datos de los videos que no contienen parasitos
son mas homogéneos con respecto a la media.

Por este método se obtienen relaciones de coeficiente de variacion de video
con y sin microorganismos que son variables (altos y bajos) que no permiten

concluir sobre el tamafio de los microorganismos.
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CAPITULO V

CONCLUSIONES Y RECOMENDACIONES

Conclusiones

La tendencia espacial se obtiene a partir de un fotograma que es una toma
instantanea de un espacio. Esto indica que los picos deben ser el reflejo del
Bioespeckle de diferentes microorganismos. Debido a esto, esta tendencia
deberia reflejar la forma y tamafio del microorganismo mientras que la
tendencia temporal deberia reflejar mejor el movimiento que a su vez puede
representar indirectamente el tamafio del microorganismo ya que los
microorganismos mas pequefios se tienden a mover mas que los mas
grandes.

El andlisis de tendencia espacial por ajuste de regiones a una tendencia
polinbmica de segundo orden, sin separar en bandas de colores conduce a
obtener los resultados esperados a través del coeficiente de variacion y de la
relacion de éste en presencia y ausencia de microorganismos. Este descriptor,
si bien puede distinguir la presencia y ausencia de microorganismos, no es
indicativo de las dimensiones ni tamafio de los mismos.

En la evaluacion de tendencia espacial por el calculo del area de la semi elipse,
si no se toman en cuenta los valores extremos (>2 y <1), se encuentra que la
relacion de areas de las semi elipses con y sin bacterias dan valores de 1,12
y 1,19, mientras que la relacion de é&reas de las semi elipses con y sin
parasitos, dan valores de 1,65; 1,73 y 1,31. Este constituye un descriptor que
pudiera estar estableciendo, no solamente la presencia de microorganismos,
sino también la diferencia en dimensiones entre bacterias y parasitos, ya que

los parasitos tendrian una relacion de coeficiente de variacion superior a las
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bacterias. Adicionalmente, es posible que este descriptor pudiera distinguir la
presencia de parasitos y bacterias en una misma muestra.

El analisis espacial separando en bandas de colores, no conduce al resultado
esperado. El hecho de que en este caso no se cumpla la relacién esperada del
coeficiente de variacion podria explicarse porque es posible que la separacion
en bandas conduzca a la pérdida de informacion o visto desde otro punto de
vista, que sea necesaria la informacion redundante como ocurre en el
procesamiento directo con las tres bandas de colores, para detectar un
fendmeno de tan baja intensidad como es el Bioespeckle. Esto seria debido a
gue en este caso habria una sumatoria de eventos que podrian revelar mejor
las diferencias.

Se observa que la tendencia temporal por via de solo promedio, desviacion
estandar y coeficiente de variacion, puede ser un buen descriptor para detectar
la presencia de microorganismos, tanto bacterias como parasitos, pero no se
logra tener una cuantificacion del tamafio del microorganismo.

La tendencia temporal en términos de ajuste de picos a una regresion
polinbmica de segundo orden, permite obtener relaciones de coeficiente de
variacion de videos con y sin microorganismos que son altos para bacterias y
un poco mas bajos para parasitos. Se estima que éste podria ser un buen
descriptor para distinguir entre parasitos y bacterias ya que el comportamiento
temporal evalGa principalmente el movimiento el cual es mayor en bacterias
gue en parasitos ya que las primeras tienen un movimiento mas rapido que los
parasitos.

En sintesis, la forma de los microorganismos puede distinguirse por el area de
las semi elipses en la tendencia espacial, siendo la relacion de areas mayor
para parasitos que para bacterias por el mayor tamafio de los primeros frente

a las segundas. Y por el movimiento en la tendencia temporal, siendo la
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relacion del coeficiente de variacion mayor para bacterias que para parasitos
debido al mayor movimiento de las primeras frente a los segundos.

A través de la tendencia espacial y la tendencia temporal, se puede distinguir
el tamafio de los dos microorganismos estudiados, cumpliendo asi con el

objetivo de este trabajo.

Recomendaciones

Establecer el significado estadistico de las diferencias encontradas en el area
de las semi elipses, en el método de la tendencia espacial.

Establecer si en el método de la tendencia temporal, las diferencias
encontradas son estadisticamente significativas.

Hacer el célculo del semi elipse sobre las medidas repetidas en el tiempo.
También se recomienda aumentar la concentracion de microorganismos para

que el efecto sea mas notorio.
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